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THE MAN WITH THE BLUE GUITAR

       I

The man bent over his guitar,

A shearsman of sorts.  The day was green.

They said, “You have a blue guitar,

You do not play things as they are.”

The man replied, “Things as they are

Are changed upon a blue guitar.”

And they said then, “But play, you must,

A tune beyond us, yet ourselves,

A tune upon a blue guitar

Of things exactly as they are.”

                    Wallace Stevens
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User’s Guide to HandLens—A Computer
Program that Calculates the Chemistry of
Minerals in Mixtures

By D. D. Eberl

Abstract

HandLens is a computer program, written in Excel  macro language,  that calculates the

chemistry of minerals in mineral mixtures (for example, in rocks, soils and sediments) for related

samples from inputs of quantitative mineralogy and chemistry.  For best results, the related

samples should contain minerals having the same chemical compositions; that is, the samples

should differ only in the proportions of minerals present.  This manual describes how to use the

program, discusses the theory behind its operation, and presents test results of the program’s

accuracy.

Required input for HandLens includes quantitative mineralogical  data, obtained, for

example, by RockJock analysis of X-ray diffraction (XRD) patterns, and quantitative chemical

data, obtained, for example, by X-ray florescence (XRF) analysis of the same samples.  Other

quantitative data, such as sample depth, temperature, surface area, also can be entered.  The

minerals present in the samples are selected from a list, and the program is started.  The results of

the calculation include: (1) a table of linear coefficients of determination (r2’s) which relate pairs

of input data (for example, Si versus quartz weight percents); (2) a utility for plotting all input

data, either as pairs of variables, or as sums of up to eight variables; (3) a table that presents the

calculated chemical formulae for minerals in the samples; (4) a table that lists the calculated

concentrations of major, minor, and trace elements in the various minerals; and (5) a table that

presents chemical formulae for the minerals that have been corrected for possible systematic

errors in the mineralogical and/or chemical analyses.  In addition, the program contains a method

for testing the assumption of constant chemistry of the minerals within a sample set.
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Introduction

Rocks and sediments are composed of minerals, and minerals are defined by their crystal

structure and chemical composition.  In addition to these variables, mineral proportions are

required to characterize a rock.  Rocks have long been characterized using chemistry alone.  For

example, normative calculations estimate quantitative mineralogy from bulk igneous-rock

chemistry by applying rules for the likely combination of elements during crystallization (for

example, Cross et al., 1902; Barth, 1962). The normative method also has been applied to

metamorphic and sedimentary rocks (for example, Piche and Jebrak, 2003; Tarrah and others,

2000).  Geochemical modeling of the composition of natural waters has been used to predict the

type and amounts of minerals that precipitate along flow paths, without necessarily analyzing

for those minerals (for example, Parkhurst and Appelo, 1999).  Elemental maps have been made

of soil landscapes, without analyzing for the defining mineralogy (for example, Shaklette and

Boerngen, 1984).

Chemistry has been emphasized over mineralogy because it was tedious and difficult to

quantify minerals accurately, especially clay minerals (Moore and Reynolds, 1997), although

Braun (1986) developed a method to limit the maximum and minimum amounts of a mineral in a

mixture by applying linear programming to integrate X-ray diffraction and chemical data, with

emphasis on the chemical data.

Recent developments have made quantitative mineral analysis much more accurate and

less tedious.  These methods include new developments using the Rietveld technique for

modeling X-ray diffraction patterns from fundamental X-ray diffraction theory (Bish and Post,

1993; Bergmann and Kleeberg, 1998; Ufer and others, 2004), and whole-pattern fitting methods

that use pure minerals as X-ray diffraction standards (Chipera and Bish, 2002; Eberl, 2003).  The

accuracy of such methods has been confirmed by the Reynolds Cup competition, in which

sample unknowns that contained up to 17 minerals each were analyzed with excellent accuracy

by at least 10 laboratories out of 37 entries worldwide (Omotoso and others, 2006).

HandLens relies on accurate mineral and chemical analyses of multiple samples and

conceptually simple mathematics to calculate the chemical composition of minerals in sets of



3

related samples.  Other methods for determining the chemistry of minerals in mixtures require

mineral separations or microprobe techniques.  The former method is laborious and sometimes

impossible, and the latter is expensive, time intensive, and the resulting micro-chemical analyses

may not be representative of the whole sample.

The samples used by HandLens must be related in that they contain minerals which,

ideally, have identical chemical compositions with minerals present in different proportions.

Such sample sets could be collected, for example, from the same rock formation in different

locations, from rock cores at neighboring depths, or from similar samples that have been

separated into different size fractions and analyzed separately.

The program calculates a correlation table for the chemical and mineralogical inputs, and

plots these relations in a chart. Concentrations of major and trace elements in the minerals are

determined by solving a set of simultaneous linear equations using the Solver tool in Excel.  A

unique mathematical solution requires that there be at least as many samples entered into the

program as there are different types of minerals in the samples.  In addition, HandLens calculates

the major element chemistries for each mineral.  This calculation applies material and charge

balance constraints to mineral compositions, and a well-constrained solution to the set of linear

equations requires that there be approximately as many samples entered into the program as

there are variable-composition minerals in the samples.  A third type of calculation allows the

measured chemistry and/or mineralogy to vary within the experimental uncertainty to refine

mineral chemistries.  Other program features include utilities for calculating the weight percent of

elements from the weight percent of elemental oxides, and the weight percent of Si by difference

when this element is missing from the analyses.  In addition, a table lists the formulae and most

intense X-ray diffraction lines for common, rock-forming minerals.  Another program,

RockGenerator.xls, generates artificial sample mineralogies and chemistries, with or without

random and systematic errors, from mineral compositions.  Such RockGenerator data are used to

test HandLens calculations.  A third program, Form.xls, calculates the formula for a pure mineral

from its chemical analysis.
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Computer requirements and disclaimer

HandLens will run under either Windows 98 (or higher versions), or Macintosh (System

X) operating systems.  Use of HandLens requires the installation of Microsoft Excel 2000, or

newer versions, but it will not run in Excel 2008 for the Macintosh because this program lacks

the Solver tool.  The program requires that Excel’s Solver option be installed and assumes that

the operator has an elementary knowledge of how to use the Excel program.  In this report, the

term “sheet” refers to a worksheet in Microsoft Excel.  Cells, such as B4, designate the cell at the

intersection of column B and row 4.  It may be necessary to use the English-language version of

Excel, but see installation step six below.  The program occupies about 24 megabytes of disk

space.  Calculation times can be long, so the fastest computer available should be employed.  On

some computers, the program often crashes after a calculation is completed and subsequent data

is entered into the program.  The best strategy to prevent frustration if this occurs is to exit Excel

at the end of a calculation (this can be done automatically), and then to open the program again.

Although this program has been used by the U. S. Geological Survey (USGS), no

warranty, expressed or implied, is made by the USGS or the United States Government as to the

accuracy and functioning of the program and related program material, nor shall the fact of

distribution constitute any such warranty, and no responsibility is assumed by the USGS in

connection herewith.

How to obtain HandLens

The latest version of the software described in this report can be obtained by anonymous

ftp from the Internet address: ftp://brrcrftp.cr.usgs.gov/pub/ddeberl/HandLens, by emailing the

author at ddeberl@usgs.gov, or by writing D. D. Eberl, U.S. Geological Survey, 3215 Marine

Street, Suite E-127, Boulder, Colorado, USA, 80303-1066.  The HandLens folder at the ftp site

can be opened by double clicking on the folder’s name (HandLens), and the files downloaded by

dragging  them onto your hard disk.  The useful files are HandLens.xls, which is the material

balance program; RockGenerator.xls, which generates electronic sample mineralogies and

chemistries that can be used to test HandLens calculations; Form.xls, which calculates mineral
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formulae; and HandLens.pdf, which is this instruction manual for the program.  Comments or

concerns about HandLens should be directed to the author (ddeberl@usgs.gov).
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Installation of HandLens
The following instructions should be followed exactly when the program is being run for

the first time.  Most of the instructions in this manual are written for versions of Excel prior to

Excel 2007, at which time Excel underwent a major change in format, and these instructions will

have to be adapted by the reader for the newer version.  However, instructions are presented

below for installation in either of the Excel programs.

Installation for Excel 2003

1.  Copy the program and related files onto your hard disk.  Double-click the files to open them.

If the files are compressed (compressed with the .exe extension), they should decompress

automatically under Windows when double clicked.  Files with the .exe extension can be opened

in the Macintosh if the Aladdin expander software is used.  If needed, the latest version of the

expander software can be downloaded for free from at: www.aladdinsys.com/expander.  After

opening the program, more of the worksheet can be viewed on the screen by reducing the zoom

size under the View menu.

2.  After the program has been opened, go immediately to the “Material balance” sheet by

clicking that tab near the bottom of the screen.  The arrows at the bottom left can be used to

scroll between tabs.  Under the Tools pull-down menu in this sheet, check to see that the Solver

tool appears.  If not, click the Add-Ins option under the same menu, and click the Solver option

box.  If the option does not install, then Solver has not been installed from the original Excel disk.

Return to the original Excel program disk and install the Solver (see the Help menu in Excel), and

then repeat the steps above.

3.  Next run Solver once in the “Material balance” sheet by choosing Solver from the

Tools menu and by clicking the Solve button.  This run will take a few minutes.  A shortcut is

possible:  when Trial Solution shows up in the lower left corner of the screen, push the Esc

key on the keyboard, and halt and stop the Solver solution.

4.  Return to the “Start” sheet by clicking on its tab at the bottom of the screen.  Now it

may be necessary to turn on Solver in the Visual Basic Editor.  To turn on Solver, go to the Tools
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menu.  Under Tools, choose Macro, then Visual Basic Editor.  A new Tools menu will appear.

Under this menu choose References.  A box will appear named Available References.  A

checked Solver box may appear in this box, especially for those using Windows.  If so, go to

paragraph 5 below.  However, especially for the Macintosh, a checked box may appear that says

MISSING:SOLVER.XLA.  If so, click the Browse button.  Twin boxes will appear.  From the

menus at the top of the boxes, it may be necessary to find Microsoft Excel Files in the Show

menu and Add-Ins in the From menu.  Choose Add-Ins in the left box, and open Solver.xla in

the right box by double clicking.  Click the Enable Macros button that appears.  SOLVER with

a checked box should appear in the Available References box.  Click the OK button.  Under the

Excel Menu, click Close and Return to Microsoft Excel.

5.  In the “Start” sheet, go to cell O229, which will have a pink font (it could be displaced

from cell O170).  This cell should show: =SOLVERSOLVE(TRUE).  This macro statement can

be seen at the top of the screen, beneath the Tools bar.  If the equation cannot be seen, then

under the Tools menu, click Options, and then under the View tab check the Show formula bar

option.  The Status bar and Windows in Taskbar options also should be checked.  If cell O229

shows only =SOLVERSOLVE(TRUE), save the program and go to the next section in this

report.  However, especially for the Macintosh, there may be a long string of letters after the

equal sign in this macro statement which indicates the address of a hard disk.  If this information

is present, it must be removed from this and other cells before the program will run.  To remove

it, copy everything that comes between the equal sign and SOLVERSOLVE(TRUE) by

highlighting it, and choosing Copy from the Edit menu.  Click the red X in the Formula bar to

return the cell value to its original state.  Under the Edit menu, choose Replace.  (In some

systems it may be necessary to choose Find first, and then Replace.)  Paste the copied material

into the Find What box.  Do not enter anything into the Replace With box.  Click the Replace

All button.  Now the unwanted material has been removed from all cells in the program.  Save the

program, and you are ready to use it.

6.  It may be possible to run HandLens under non-English language versions of Excel if

the user is willing to do some work.  Most of the code is translated automatically into the non-
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English version, but there are a few words that must be changed manually.  It is necessary to

replace the word SOLVER with the non-English equivalent.  In Spanish, for example, the word is

SOLV (see Spanish Excel instructions to find the word). To replace words in the program,

follow the instructions in paragraph 5 above.  In addition, the Solver commands need to be

modified in the “Material Balance” sheet (Cells A28:A30, A32:A34, A36:A38, A40:A42, and

A44:A46).  Click on cell A28 to choose it.  Under the Tools menu choose Solver.  Make the

following changes in the Solver box that appears on the screen:  under By Changing Cells,

erase the current entry and type $A$3, if necessary; under Subject to Constraints, choose each

entry and click Delete so that this box is empty.  Next click on the Options button which is a

part of the Solver box that is on the screen, and then click the Save Model button.  Click OK

twice, and close the Solver box.  Now cells A28:A30 should contain the non-English language

equivalent of the English entries.  It may be necessary to separate the entries in Cell A30 with

slashes (/) rather than with commas or semicolons (, or ;).  Now repeat the same procedure with

the other triple cells listed above.  If the program runs, Save it and give thanks.

Installation for Excel 2007

The advantage of Excel 2007 is that it can use the additional speed of multiprocessors.

Excel 2008 for the Mac will not run HandLens because this version of Excel does not contain the

Solver.

The Byzantine route for converting HandLens from Excel 2003 to Excel 2007 is as

follows:

1.  Open Excel 2007.

2.  Under the Office Button, open HandLens.xls.

3.  Under the Office Button, Save as, Excel Macro-Enabled Workbook.  The program

is saved separately as HandLens.xlsm.

4.  Under the Office Button, Exit Excel.

5.  Open HandLens.xlsm in Excel 2007.
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6.  Click the Material balance tab at the bottom of the sheet.  You may have to scroll to

find it.

7.  Click the Data tab at the top of the sheet.  In the Analysis section (far right top), click

the Solver tool.  If there is no Solver tool, then install the Solver by following the directions

given in Excel help.  Also install the ToolPak Add-in (without VBA).

8.  After having clicked the Solver tool, when the Solver box appears, click Close.

9.  Click the Start tab at the bottom left of the sheet.

10.  Click the Home tab at the top left of the sheet.

11.  In the Editing section (far right top), click Find & Select, then Replace.  Next to

Find What: enter the word SOLVER.  Next to Replace with: enter SOLVER again.

12. Click Replace All.  There should be 204 replacements.  Close the box.

13. Click the tab for Manual plots at the bottom of the sheet.

14. On the chart in this worksheet, click on the label for the x-axis, which should read

Kspar.

15. In the formula bar near the top of the sheet, click in the formula, which should read:

=’Manual plots’!$D$4.  This procedure somehow wakes up the chart labels.

16. Follow the same proceedure to wake up the 8 labels on the y-axis of this chart.

17. Follow the same proceedure in the Results3 sheet to wake up the K label in the

upper right corner of the chart.

18. Under the Office Button, click Save.
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How to Run HandLens
1. If the program is being used for the first time, follow the installation instructions given

above.  Make a copy of the program and run the copy.

2. Enter data only in cells that contain bold red font!  Never cut and paste, only copy and

paste data values.  After copying data, choose Paste Special under the Edit menu, then

Values to paste.

3. Previous data can be erased by entering a 2 into cell B4 and clicking the Start button.

Before doing this the first time through, look at the input sheets to see how the data is

entered, and run the program with its current data set to be sure that it works.

4. In the “Start” sheet, indicate the minerals present by entering the number 1 into the

appropriate cells in column F.  There is a 17 mineral limit.

5. Run Mineral Setup by entering 1 into cell B4 and clicking the Start button.

6. In the “Input mineralogy” sheet, enter the sample names into column B and the weight

percents of each mineral into the cells indicated.  There is a 400 sample limit.  Some of the

minerals analyzed can be combined into a single category.  For example, orthoclase and

microcline weight percents can be added together, and the sum entered as potassium

feldspar (Kspar).  For best results, mineral weight percents for each sample should sum to

100 percent.  The experimental uncertainty for each mineral can be entered into row 2.  For

example, a ± 6 percent uncertainty is entered as 0.06.

7. In the “Input major chem” sheet, enter weight-percent elements (not elemental oxides)

where indicated.  They do not sum to 100 percent because the anions are missing.

Experimental-measurement error can be entered into row 2 as is described above.  If the

chemical data comes in the form of weight-percent elemental oxides rather than as elements,

then these values can be converted into weight-percent elements in the “Oxide conversion”

sheet.  If the element Si is missing from the analyses, it can be calculated automatically by

difference in the “Si calc” sheet by entering the weight-percent major elements into

columns D through K.  The weight-percent Si will appear in column C.
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8. In the “Input trace chem” sheet, enter the element symbols into row 4, and the ppm values

for the trace elements into the cells below.

9. In the “Input other” sheet, enter other data for the samples, such as depth, temperature,

latitude, surface area, cation exchange capacity.  Enter the name of the type of other data into

row 4, and the data itself into the cells below.

10.  In the “Start” sheet, enter the number for the analysis option into cell B10, and the number

of samples to be analyzed simultaneously into cell B15.  Indicate whether or not major

elements are to be analyzed with the trace elements (for example, without constraints) in cell

B17, whether Fe2+ should be a part of the Solver solution in cell B20, and how many times

to iterate the calculation in cell B22.  Explanations for these inputs will be given below, and

the other inputs are self explanatory.

11.  Click the Start button.  Column A in the “Start” sheet lists where the answers will appear.

Analysis Options

Option 1: Analyze data for correlation table & plots

Start the calculation by entering number 1 in cell B10 of the “Start” sheet, and by clicking

the Start button.  When the calculation is complete, open the “Correlation table” sheet by

clicking its tab at the bottom of the screen.  The table gives the coefficient of determination (r2)

for all paired variables, and highlights the best correlations in bold green font.  The threshold for

being highlighted can be changed prior to the calculation by changing the value in cell A7 from a

minimum of zero to a maximum of 1.  The coefficients of determination can be multiplied by 100

to find the percent of variance in common between the paired variables.

The next sheet, “Manual plots”, is a utility for plotting the input data, and can be

activated by entering the reference number (from column A, with reference to column B) into cell

D3 for the material to appear on the X axis, and the reference numbers for the Y axis into cells

E3:L3.  The values for columns E through L are added together when plotted.
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Option 2: Calculate mineral formulae

Start this calculation by entering 2 into cell B10 of the “Start” sheet, and by clicking the

Start button.  Option 1 also will be calculated.  Option 2 calculates the formulae for minerals in the

samples by solving a series of simultaneous equations, as will be described in a later section of this

report, and is based on the assumption that each mineral has the same chemical composition in all

samples.  There should be as many equations in the calculation as there are unknowns.  Therefore,

it is safest to have at least as many samples in the calculation as there are minerals that have variable

compositions, although, due to complexities in the mathematics, it may be possible to use fewer

samples for some calculations.  The number of samples and variable minerals in the calculation are

displayed on column A on the “Start” sheet after running Mineral setup.  The range of

compositional variation of each mineral is set in the “Input formulae” sheet, as will be discussed in

a later section of this report.

The number of samples to be solved simultaneously can be set in cell B15 of the Start

sheet.  Enter “All” to analyze all samples simultaneously.  For a 10 sample set, for example,

entering a 5 into this cell will cause the first 5 samples to be analyzed simultaneously, and then

the next 5.  The results for these two calculations will be reported separately in the “Results2”

sheet.  By entering a negative number, for example -5, the samples will be analyzed 5 samples at

a time as a moving average.  Samples 1 to 5 will be analyzed, followed by samples 2 though 6,

and so forth, and the results will be reported separately.  One needs to run enough samples

simultaneously to find a unique solution, but not so many as to stretch the assumption of a

constant chemistry for each mineral.
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Many chemical analyses report total iron rather than ferric and ferrous iron separately.

HandLens will calculate ferrous iron from total iron when 1 or 2 is entered into cell B20, by

making the ferrous/ferric ratio a part of the Solver solution.  There is a 30 or 64 sample limit,

depending on which option is chosen.  The 64 sample limit excludes Ti and H2O+ from the

calculation.  Samples that contain minerals that have a fixed ferrous iron content (for example,

pyrite) can be calculated without turning on this option (for example, enter 0 into cell B20).

Cell B22 indicates how many times the calculation will be iterated to find the correct

formula weights for the minerals.  The first iteration uses the formula weights for the mineral

compositions entered into the “Input formulae” sheet.  This weight is then refined as the

calculation proceeds and the mineral compositions are adjusted.  Generally two or three iterations

are sufficient to converge on a formula weight.

The results for Option 2 are presented in the “Results2” sheet, starting in column AC.

The upper table (rows 1 through 20) reports initial mineral chemistries (from the “Input

formulae” sheet) before the calculation began, and the tables below report results for the

calculations.  Structural formulae can be written from the atomic distributions given in the tables

for each mineral.  Moving to the left in this spreadsheet, by entering a reference number in cell F2

(reference is to the table in columns B and C), minerals of the same type from multiple solutions

can be compared.  Cell A9 gives the Solver status at the end of the calculation, and will read 0 or 1

if the calculation is valid.  If  Solver encounters an error, you may be attempting an impossible

calculation, so cell A9 should be checked to insure that Solver found a valid solution.  Moving to

the right in the spreadsheet, by entering a reference number in cell BI2 (reference to table in cells

BE3:BF12), the calculated versus the measured weight percent of an element can be compared for

the entire sample set.  Ideally, the regression line should have a slope of 1 and an intercept of 0.

Deviation from this ideal indicates how well the assumption of equivalent chemistries for

minerals of a given type is obeyed in all samples.
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Option 3: Distribute elements among minerals

Start this calculation by entering 3 into cell B10 of the “Start” sheet, and by clicking the

Start button.  If 0 has been entered into cell B17, then the concentrations of all analyzed

elements in the minerals will be calculated.  If the number 1 has been entered into cell B17, then

concentrations for the trace elements only will be calculated.  This calculation is accomplished

without assuming any constraints for mineral compositions by solving a series of linear equations

simultaneously.  There must be at least as many samples in the calculation as there are different

types of minerals in the samples for the calculation to be mathematically constrained.  As with

previous calculations, it is assumed that elemental concentrations are constant for each mineral

type.

The results appear in the “Results3” sheet, starting in column EX, and are presented in

concentration units of weight percent for the major elements, and ppm for the trace elements.  As

an example, Si should have a concentration in quartz of 46.7 weight percent (100 x atomic weight

of Si/molecular weight of quartz = 100 x 28.09/60.09).

Plots of measured versus calculated elemental data can be viewed near column E by

entering an element’s reference number (see columns B and C) into cell F2.  The points should

fall on a regression line that has a slope of 1 and an intercept of zero if the assumption of a

constant chemistry is obeyed.

The results of the Option 3 calculation indicate only that a particular element

accompanies a particular mineral, not that it is a part of the mineral’s structure.  One can

speculate, for example, that Ba and Zr may accompany quartz, but may be present in trace

amounts of barite and zircon that were not detected by X-ray diffraction, rather than being

present in the quartz structure.  The Ba, and Zr may correlate with quartz because they occur in

resistant minerals that were concentrated together by weathering.

Option 4: Calculate mineral formulae within uncertainty limits

Start the calculation by entering 4 into cell B10 of the “Start” sheet, and by clicking the

Start button.  This option will calculate mineral formulae using Option 2 first, and then calculate
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the formulae by assuming that the mineralogy and/or major element chemistry can vary within

the uncertainty limits set in the “Input mineralogy” and “Input major chem” sheets.  The results

will appear in the “Results4” sheet, starting in column AC.  The uppermost table gives the initial

formulae that were entered into the “Input formulae” sheet, to be discussed below.  The mineral

and element multipliers used to correct the data can be read in the tables.  As in Option 2, the

chemistry for minerals of a given type can be compared for separate simultaneous calculations by

entering the mineral’s reference number (see columns B and C) into cell F2.

Option 5: Run all of the above options

Start the calculation by entering  5 into cell B10 of the “Start” sheet, and by clicking the

Start button.  This option will calculate Options 1 through 4 with one click of the button.

Option 6: Enter new standard into the Input formulae sheet
Start the calculation by entering 6 into cell B10 of the “Start” sheet, and by clicking the

Start button.  This option will enter a new or revised standard mineral formula into the program,

after the formula has been added or revised in a table in the “Input formulae” sheet, as will be

discussed in the next section of this report.
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How To Enter A New Mineral Formula Into HandLens

Mineral chemistries calculated by Options 2 and 4 are restricted by material and charge-

balance constraints.  To enter new minerals into the program, or to revise chemistries for minerals

that are already in the program, mineral formulae and constraints must be entered into the “Input

formulae” sheet, and then introduced into the program by running Option 6 from the “Start”

sheet.

To enter a new mineral, go to the “Start” sheet.  Enter the mineral’s name after the last

mineral name in column E.  Note the number, given in column D, of the new mineral.  In column

G, opposite the new mineral’s name, indicate whether it has a fixed (0) or variable (1)

composition.  Go to the “Input formulae” sheet, and enter the mineral’s number into cell E8, and

its name into cell F8 in the Formula Editing Table.

Next enter the mineral’s starting composition and the upper and lower limits for its

chemistry in cells G8:AS8.  Models for this input can be followed in the Chem Substitution

Input Table below the Formula Editing Table.  Using calcite (CaCO3, with the possibility for

0.3 atoms of Mg substitution for Ca) as an example, enter zeros in all cells in the range G8:AS8,

except for the following cells.  Enter the simplest formula for calcite first, by entering 1 into cell

S8, thereby indicating 1 atom of Ca, and 1 into cell AN8, thereby indicating 1 molecule of CO3.

This is the starting formula for calcite that will be used in the material and charge balance

calculations for Options 2 and 4.  Check to see that the mineral is electrically balanced by

consulting cells F5 or AU8, which should read zero.   Since there is a range of Mg substitution in

this mineral (up to 0.3 atoms per Ca position), enter the upper limit for Ca (1.0) into cell S8, and

the lower limit (1.0 – 0.3 = 0.7) into cell U8.  Enter similar information for Mg, by entering 0.0,

0.3 and 0.0 into cells P8:R8.

Next enter the constraint equations and constraint constants into rows 31 and 32, starting

in cells G31 and G32.  The constraint equations refer to the atoms and numbers of atoms listed in

cells G9:P11, and not to those listed in row 8.  A constraint equation for calcite would be, for

example,  =J11+K11, which would be entered into cell G31.  The constraint constant is 1,

because the sum of Mg and Ca atoms for this mineral must equal 1; so the number 1 should be
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entered directly below the constraint equation, into cell G32.  Another constraint equation and

constant for calcite would be: =2*(J11+K11)-2 entered into cell H31, and the constant 0 entered

into cell H32, which describes charge balance (the valences of Mg and Ca times the number of

atoms of each, minus the charge of 1 molecule of CO3 equals zero).  One can enter less than or

equal to constraints and constants, or greater than or equal to constraints and constants in a

similar manner into cells O31:R32.

In order to enter this formula into the program, it now is important to go to the “Start”

sheet, run Option 6, and save the program.  Option 6 will paste the number of atoms for the

mineral into the correct position in the Chem Substitution Input Table found in rows 41:144,

and the constraint equations and constants into the correct position in the table found in rows

147:347.

To alter the equations for a mineral that already is entered into the program, please follow

these directions exactly.  Using illite as an example, highlight and copy cells E64:AS64.  Select

cell E8 by clicking on it, and under the Edit menu choose Paste Special, Values.  Next copy

cells G186:R187.  Select cell G31, and under the Edit menu choose Paste Special, Formulas.

Edit the mineral’s formula and constraints as desired.  Then go to the “Start” sheet, run Option 6,

and save the program.

Typical chemical formulae for common minerals are listed in the “Mineral index” sheet.

Ranges for mineral compositions can be found, for example, in Deer and others, 1992.  Formulae

in the “Input formulae” sheet should be checked prior to calculation to insure that they have not

been altered by someone during previous calculations.
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Theory Behind the Operation of HandLens

The calculation of Option 3 in HandLens, an option that distributes elements among

minerals without material-balance or charge-balance constraints, is based on the definition for

concentration.  As an example, the concentration (ppmBaSample) of the trace element Ba in a

sample containing potassium feldspar (Kspar) as the exclusive Ba-containing source is

represented:

€ 

ppmBaSample =%KsparSample × ppmBaKspar ×10
−2. (1)

It is trivial to calculate the concentration of an element in a mineral for a sample that contains

only one mineral, or in a sample that is known to contain the element in just one mineral.  The

concentration of Ba in the sample (ppmBaSample) can be analyzed, for example, by inductively

coupled plasma mass spectrometry (ICP-MS), and the weight percent of potassium feldspar in

the sample (%KsparSample) can be determined by quantitative X-ray diffraction (for example,

RockJock program; Eberl, 2003).  If there are two Ba-containing minerals (for example, Kspar

and muscovite, Musc) in a sample, however, then there no longer is a unique solution to the

problem, because there are two unknowns (the concentrations of Ba in Kspar and in muscovite),

but just one equation:

€ 

ppmBaSample = %KsparSample × ppmBaKspar +%MuscSample × ppmBaMusc( ) ×10−2 .

(2)

A second equation is added by analyzing a second sample that has the same concentration of Ba

for each mineral, but that has different proportions of Kspar and muscovite.  By extension, at

least as many samples are required as there are different types of minerals in the samples to find

a unique concentration for each element in each mineral.

The simultaneous equations could be solved by linear programming (for example, Braun,

1986), but in HandLens they are solved by using Excel’s powerful Solver tool in the Material

balance sheet.  Using Equation (2) as an example, but applying the equation to at least two

samples simultaneously, with ppmBaSample , % KsparSample, and %MuscSample known from the
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analysis of each sample, the ppm of Ba in Kspar and muscovite are varied by the Solver until the

difference in the sum of the R2’s between the measured ppmBaSample and those calculated from

equations similar to (2) are minimized for all samples simultaneously, where:

€ 

R2
Sample1

SampleN
∑ = Measured ppmBa( )SampleN −Calculated ppmBaSampleN( )[ ]

2
∑ .               (3)

HandLens will solve for concentrations of an element in up to 17 minerals and 400 samples

simultaneously.

A similar approach is used for calculating the major element composition of each mineral

(Option 2), but in this case the variability of the major elements can be constrained in Solver by

the known compositional variability of each mineral, and by charge balance considerations.    For

this option, HandLens solves equations analogous to Equations 2 and 3 for all major elements in

all minerals simultaneously, with the solutions being limited in Solver by constraints that have

been entered into the Input formulae sheet.

Option 4 starts with mineral compositions calculated by Option 2, and then also varies

the weight percents of the minerals and/or the elements, within the ranges given by the error

values entered into the Input mineralogy and Input major chem sheets, to minimize the sum of

the R2’s.

Tests of HandLens Using RockGenerator

The program RockGenerator.xls generates chemical compositions for imaginary or real

samples from inputs of mineral chemical formulae and weight percent minerals.  Weight percents

for the minerals in each sample can be entered manually, or can be calculated automatically by

assuming a random distribution of quantitative mineralogy for each sample.  Trace element

concentrations for each mineral also are entered either manually or automatically.  The program’s

output of artificial sample chemistries then can be used to test the HandLens program, and to

back calculate HandLens solutions for real samples.  RockGenerator also will generate error,
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either random (Gaussian), systematic, or both, for quantitative mineralogy and chemistry to

further test HandLens.  Instructions for using RockGenerator are included in the “Start” sheet of

the RockGenerator program.  Be sure to turn on the Analysis ToolPaks under the Tools menu

in RockGenerator.

Tests of Option 1: analysis of data for the correlation table and plots

Option 1 does not require extensive testing, because it simply plots the input quantitative

mineralogy, chemistry, and other data against itself.  One should be aware that the correlations in

the “Correlation Table” sheet may have a positive or negative slope, because the sign of the slope

is not expressed in r2.  Regression equations in the “Manual plots” sheet can reveal chemical

information concerning pure phases by extrapolating the linear regression to the pure mineral at

100 percent.

Tests of Option 3: assigning trace elements to the minerals
Ten minerals were chosen for analysis.  Mineral-weight percents in each sample and

trace-element ppm for each mineral were generated randomly and automatically in

RockGenerator.  The mineral weight percents and the overall concentrations of the trace elements

for each sample then were entered into HandLens, which calculated the trace element

concentrations for each mineral.  These values then were compared with those that had been used

in RockGenerator.

The first test was whether or not Option 3 in HandLens can calculate accurately

concentrations of elements in minerals under ideal conditions.  These conditions included the

presence of as many samples (10) as minerals in the calculation, a random distribution of mineral

weight percents among samples, no random or systematic error in chemical or mineralogical data,

and constant compositions for the minerals.  HandLens performed nearly perfectly under these

conditions (r2 = 1.00, with an intercept close to 0, and a slope of 1.00; fig. 1A). The same

calculation was performed with 20 samples, with identical results; but with 9 samples, one less
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than the minimum number required for a mathematically unique solution, the solution is

somewhat degraded, with r2 = 0.94, an intercept of 2.69, and a slope of 0.94 (fig. 1B).

The next test was to introduce ±10 percent Gaussian-distributed random error (0.10 is

one standard deviation) into the ppm trace elements assigned to each sample.  This error could be

both measurement uncertainty and error in the assumption of a constant composition for each

mineral.  With 10 samples included in the calculation, the solution no longer is accurate ( r2 =

0.35; fig. 2A).  For the same calculation, but with 20 samples, the accuracy improves

considerably, with r2 = 0.84 (Fig. 2B).  The same calculation, with 20 samples having a 5 percent

rather than a 10 percent error, gave essentially the same r2 (0.85), indicating that the number of

samples used in the calculation may be more significant than uncertainty in the measurement.

One can determine the accuracy of an Option 3 calculation by consulting the chart in the

“Results3” sheet, which is near column F.  This graph plots the measured concentration of an

element for each sample versus the sample concentration calculated by summing the calculated

concentrations of that element in all minerals for each sample.  If a trace element’s concentration

varies widely for a given mineral, there will be considerable scatter in this regression for that

element.
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Figure 1.  Tests of Option 3 using errorless chemistry (RockGenerator data) for 15 trace elements,
for a 10 or 20 sample solution (A), and a 9 sample solution (B).
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Figure 2. Tests of Option 3 for input trace element chemistries having 10 percent random
(Gaussian) error for (A) a 10 sample solution, and (B) a 20 sample solution.
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Tests of Option 2: calculation of mineral formulae

Ten minerals were chosen for analysis, eight of which had variable compositions (table 1).

Ten sample chemical compositions were calculated by the RockGenerator program for randomly

chosen proportions of the minerals.  The sample chemistries and quantitative mineralogies were

entered into HandLens to test whether the original mineral chemistries could be recovered

accurately.  Mineral chemistries are compared quantitatively by calculating bias, which is defined

as the sum of the absolute difference in stoichiometry between input and output mineral

chemistries.   The number of atoms for each mineral was converted into structural formulae for

presentation here.  HandLens gave mineral chemistries that were identical to those entered into

RockGenerator, with a bias sum of zero (table 1), demonstrating that Option 2 in HandLens

works perfectly for errorless data.

Table 1.  Test of HandLens Option 2 for a 10 mineral and 10 sample data set.

Mineral
RockGenerator Input & HandLens output formulae are

identical Bias

Quartz SiO2 0.00
Kspar K0.95Na0.05AlSi3O8 0.00

Plagioclase Na0.85 Ca0.15Al1.15Si2.85O8 0.00
Calcite Ca0.95Mg0.05CO3 0.00
Pyrite FeS2 0.00

Smectite (Al1.60Mg0.30Fe2+
0.10)(Si3.90Al0.10)O10(OH)2(Ca0.20 K0.10) 0.00

Illite (Al1.20Fe3+
0.50Mg0.10Fe2+

0.20)(Si3.50Al0.50)O10(OH)2(K0.80) 0.00
Muscovite (Al1.80Fe3+

0.20)(Si3.00Al1.00)O10(OH)2(K1.00) 0.00
Biotite (Fe3+

0.50Mg0.50Fe2+
2.00)(Si2.50Al1.50)O10(OH)2(K1.00) 0.00

Chlorite (Mg4.00 Fe3+
1.00 Fe2+

1.00)(Si3.00Al1.00)O10(OH)8 0.00

TOTAL BIAS 0.00

The same calculation was made, but with 20 samples having a 6 percent random error

(Gaussian distribution of random error with one standard deviation of 0.06) in both mineralogy

and chemistry.  The results of this calculation (table 2) were not perfect (bias = 1.93), but the

chemical formulae for the minerals are close to the input values.  The same calculation made with

10 samples gave almost double the bias (3.60).
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Table 2.  Test of HandLens Option 2 for a 10 mineral and 20 sample data set, having 6 percent

random error for mineral and chemical data.  Input formulae are in Table 1.

Mineral
HandLens output formulae

(see table 1 for input formulae) Bias

Quartz SiO2 0.00
Kspar K0.92Na0.08AlSi3O8 0.06

Plagioclase Na0.80Ca0.17K0.03Al1.17Si2.83O8 0.13
Calcite Ca0.93Mg0.07CO3 0.03
Pyrite FeS2 0.00

Smectite (Al1.69Mg0.31Fe2+
0.10)(Si3.71Al0.29)O10(OH)2(Ca0.22 K0.16) 0.65

Illite (Al1.05Fe3+
0.49Mg0.12Fe2+

0.33)(Si3.57Al0.43)O10(OH)2(K0.80Ca0.04) 0.49
Muscovite (Al1.72Fe3+

0.28)(Si3.00Al1.00)O10(OH)2(K0.90 Na0.10) 0.36
Biotite (Fe3+

0.48Mg0.43Fe2+
2.07 Al0.02)(Si2.50Al1.50)O10(OH)2(K1.00) 0.17

Chlorite (Mg4.02 Fe3+
1.00 Fe2+

0.98)(Si3.00Al1.00)O10(OH)8 0.03

TOTAL BIAS 1.93

Tests of Option 4: correction of systematic measurement errors for formulae

Ten minerals and 20 samples were chosen for analysis as above, but for this calculation a

systematic error of 6 percent (true Si value x 1.06) was introduced in the weight-percent Si values

to determine if this error could be corrected using Option 4.  In this option, one or more of the

chemical or mineralogical inputs is included in the Solver calculation and is varied within

uncertainty limits set in the Input mineralogy and Input major chem sheets.  Uncertainty limits

for all minerals and elements were set to zero, except for Si, which was set to 0.10.  Such a

calculation could be used, for example, to correct inaccurate Si values that had not been measured

directly, but calculated by difference.  The calculation gave a bias from Option 2 of 2.28 for the

uncorrected data, and a bias from Option 4 of 0.24 for the corrected data, indicating that the

Option 4 was successful in this limited test.

Tests of Fe2+ calculation from total iron

Often chemical analyses do not distinguish between Fe3+ and Fe2+, but instead report

total iron as Fe3+.  HandLens offers the option of calculating Fe2+ from total iron as a part of the
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Solver solution.  This was attempted with 20 samples and the same mineral data set as was used

above, except ferrous and ferric iron were added together and entered into the “Input major chem”

sheet as Fe3+.  Cell B20 was set to 1.  The resulting mineral formulae had a total bias of 3.44, and

Fe2+ was not accurately assigned to the variable, Fe2+-containing minerals.  On the other hand, the

same calculation, but with this option turned off (cell B20 set to 0), gave a bias of 16.4.

It was determined that the previous calculation was too complex because it contained 5

minerals that had variable amounts of  Fe2+ (table 1).   The calculation was simplified by

removing smectite and illite.  In this case, the assignment of  Fe2+ was accurate, with a total

chemical bias for the minerals of 0.28.  With only illite removed, the bias was 0.69, and the Fe2+

assignment was accurate, except that the calculation missed the 0.10 atoms of Fe2+ in the smectite

structure (table 1).

Other tests of HandLens

There is much more testing that could be done, but it is left to the reader’s innovation to

test HandLens solutions according to their particular analytical needs.

Applications of HandLens

With this program, the large amounts of chemical data that are being generated by multi-

element analysis techniques can be put into a mineralogical context, and used to solve geological

and environmental problems.  We have used it, for example, to find the origin of arsenic in the

Mancos shale (pyrite in our shale samples contains about 300 ppm As), of cadmium and zinc in

soils from Nome, Alaska (these elements occur with muscovite, and therefore are not likely to be

readily available for uptake by plants), and of arsenic in river sediments from New Jersey

(arsenic is in the clay fraction, and therefore is less concentrated in stream sediments where the

water runs fast and washes out the clay).  If used intelligently and with discretion with excellent

data, HandLens is an accurate and convenient tool for integrating chemistry and mineralogy.
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